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Q: Hoe programmeer ik een Hitachi PLC vanuit CODESYS v3.5.x.x? 
 
A: Dit document geeft hier uitleg over. 
 
 
 

Hitachi CODESYS Package 
Om Hitachi CPU’s te gebruiken binnen de ontwikkelomgeving van CODESYS 3.5, moeten de juiste 
‘Device Description Files’ worden geïnstalleerd. De ‘Device Description Files’ van alle Hitachi CPU’s 
en de bijbehorende hardware zijn samengevoegd in één bestand, een zogenaamd Package. De 
laatste versie van deze Package kan worden gedownload vanaf onze website bij een van de Hitachi 
PLC’s, onder het tabblad ‘Software’. 

 
Dit package bestand kan worden geïnstalleerd door er in Windows verkenner op te dubbelklikken. 
 

USB Driver 
Wanneer de Hitachi Package is geïnstalleerd, is het raadzaam om eerst ook de USB-driver voor de 
CPU te installeren. Met behulp van de USB-kabel kunnen de netwerkinstellingen verzonden worden 
naar de CPU zodat deze vervolgens ook via het netwerk te benaderen is. 
 
De USB driver is alleen compatible met 32-bits versies van CODESYS en werkt niet goed samen met 
CODESYS versies nieuwer dan 3.5.12.x. Wanneer een nieuwere versie van CODESYS wordt gebruikt, 
kan het nodig zijn om handmatig het bestand ‘Config.cfg’ aan te passen. De juiste inhoud van dit 
bestand (voor het gebruik van een USB kabel) is te vinden als bijlage in dit document. 
 
Sluit de juiste USB-kabel aan tussen de CPU en de PC. Na enige tijd zal de PC melden dat er geen 
driver is gevonden voor het apparaat, of staat er opeens een onbekend apparaat in het 
Apparaatbeheer. De driver voor de Hitachi CPU’s is tijdens de installatie van de Package op het 
bureaublad geplaatst in de map ‘Driver’. Installeer deze driver voor het onbekende apparaat en 
daarna zal er in het Apparaatbeheer een nieuw apparaat met de naam ‘Lib Usb Device’: 
 

 
Nadat de USB-driver is geïnstalleerd mag de map ‘Driver’ van het bureaublad worden verwijderd en 
moet de PC opnieuw worden opgestart. 
 

Nieuw project 
Daarna kan er een nieuw project worden aangemaakt in de CODESYS ontwikkelomgeving door in 
het menu de optie File → New Project… te kiezen. 
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Kies bij Templates de optie ‘Standard project’, geef een projectnaam en een 
locatie op en kies de te gebruiken CPU. Vervolgens wordt er een nieuw project 
aangemaakt, waarin automatisch de laatste versie van de compiler wordt 
gebruikt en de nieuwste firmwareversie voor de CPU wordt gekozen. 
 
De gebruikte firmwareversie voor de CPU is meestal terug te vinden op het typeplaatje aan de 
zijkant van de PLC. Het is echter ook mogelijk om dit via de software te doen: 

• Dubbelklik op de CPU in het project, waardoor een venster met de eigenschappen van de CPU 
worden getoond. Klik in het eerste tabblad op de knop ‘Scan network…’. 

• Vervolgens wordt er een nieuw venster geopend, waarin alle juiste CPU’s worden getoond. 
Wanneer de juiste CPU wordt geselecteerd, zijn de eigenschappen van de betreffende CPU 
zichtbaar. De laatste regel van deze informatie bevat de firmwareversie van de CPU. 

 
 
Wanneer in CODESYS dus een nieuw project wordt aangemaakt dan zal het pakket automatisch 
kiezen voor de laatst beschikbare firmwareversie. Indien echter een bestaand (ouder) type CPU 
geprogrammeerd moet worden, moet de gewenste firmwareversie van de CPU in het project 
worden aangepast. 
 

Om in CODESYS de juiste firmwareversie te selecteren, moet met de 
rechter muistoets op de PLC geklikt worden en vervolgens in het pop-
up menu de optie Update Device gekozen worden. 
 
Er wordt vervolgens een nieuw venster geopend, waarin de juiste 
versie van de ‘Device Description File’ kan worden gekozen, welke 
hoort bij de firmwareversie van de CPU. 
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Standaard zullen in dit venster alleen de nieuwste versies van de ‘Device Description Files’ zichtbaar 
zijn, maar door de optie ‘Display all versions’ aan te vinken, worden alle aanwezige versies getoond: 
 

 
 
Wanneer de firmwareversie het vereist, kan hier dus een andere versie van de ‘Device Description 
File’ worden gekozen, waardoor de gegenereerde software compatibel is met de hardware. 
 
Opmerking voor oudere versies van CODESYS 3.5: 
Indien de optie ‘Display all versions’ niet te selecteren is, moet 
in het menu Tools → Options in het submenu Features – 
Device management de optie ‘Enable simplified device 
handling’ uitgeschakeld worden! 
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Device versie 
In de tabellen op de volgende bladzijden staat weergegeven welke versie van de ‘Device Description 
File’ moet worden gebruikt voor elke firmwareversie. Ook staat in de tabel vermeld welke versie 
van de libraries wordt ondersteund. 
 
HX CPU: 

 
 

HX CPU 
Firmware version 3.5.16.22 - 26 3.5.13.40 / 41 3.5.8.26 3.5.8.21 - 24 

Device description 3.5.16.22 - 26 3.5.13.40 / 41 3.5.8.26 3.5.8.21 - 24 

Hardware revision 00 00 00 00 

Runtime version 3.5.16.22 3.5.13.40 3.5.8.22 3.5.8.22 

Compiler version 3.5.16.20 3.5.13.20 3.5.8.20 3.5.8.20 

Supported 
device version 

EtherCAT Master 3.5.16.20 3.5.16.0 3.5.10.0 3.5.10.0 

Ethernet Adapter 3.5.16.0 3.5.13.0 3.5.10.0 3.5.8.20 

Modbus TCP Master 3.5.16.0 3.5.13.0 3.5.8.10 3.5.8.10 

Modbus TCP Slave 3.5.16.0 3.5.12.0 3.5.8.10 3.5.7.0 

Modbus TCP Slave Device 3.5.16.0 3.5.13.0 3.5.5.0 3.5.5.0 

Modbus COM* 3.5.16.0 3.5.11.20 3.5.11.20 - 

Modbus SIO-COM** 3.5.8.21 3.5.8.20 3.5.8.20 - 

Modbus Serial Device 3.5.16.10 3.5.13.20 3.5.5.0 3.5.5.0 

Modbus Master, COM Port 3.5.16.0 3.5.13.10 3.5.8.10 3.5.8.10 

Modbus Slave, COM Port 3.5.16.0 3.5.10.30 3.5.4.0 3.5.4.0 

EH-SIO 3.5.8.22 3.5.8.22 3.5.8.21 - 

EH-LNK 3.5.8.21 3.5.8.21 3.5.8.21 3.5.8.20 

Supported 
library version 

IODrvEtherCAT 3.5.16.0 3.5.16.0 3.5.8.0 3.5.8.0 

IoDrvBase 3.5.13.0 3.5.13.0 3.5.5.0 3.5.5.0 

IoDrvUtility 3.5.16.0 3.5.11.0 3.5.10.0 - 

ModbusTCP Slave 3.5.16.0 3.5.13.0 3.5.8.10 3.5.8.10 

IoDrvModbusBase 3.5.16.0 3.5.13.0 3.5.8.10 3.5.8.10 

IoDrvModbusTCP 3.5.16.0 3.5.13.0 3.5.8.10 3.5.8.10 

CmpApp 3.5.15.0 3.5.13.0 3.5.8.0 3.5.8.0 

CmpEventMgr 3.5.16.0 3.5.12.0 3.5.8.0 3.5.8.0 

CmpIecTask 3.5.14.0 3.5.13.0 3.5.8.0 3.5.8.0 

CmpIecVarAccess 3.5.15.0 3.5.13.0 3.5.7.0 3.5.7.0 

IoStandard 3.5.16.0 3.5.13.0 3.5.8.0 3.5.8.0 

SysCom 3.5.15.0 3.5.5.0 3.5.5.0 3.5.5.0 

SysSocket 3.5.15.0 3.5.13.0 3.5.8.0 3.5.8.0 

SysTimer 3.5.5.0 3.5.5.0 3.5.5.0 3.5.5.0 

SysTimeRtc 3.5.5.0 3.5.5.0 3.5.5.0 3.5.5.0 

UDP 3.5.16.0 3.5.10.0 3.5.8.0 3.5.8.0 

TCP 3.5.15.0 3.5.9.50 3.5.8.10 3.5.8.10 

FDT Manager - - 3.5.3.30 3.5.3.30 

NetVarUdp 3.5.16.0 3.5.12.0 3.5.8.0 3.5.8.0 

* Gebruik i.c.m. CODESYS 3.5 SP16 of nieuwer device versie 3.5.16.0, ook voor CPU’s met oudere firmware 
** Gebruik i.c.m. CODESYS 3.5 SP16 of nieuwer device versie 3.5.8.21, ook voor CPU’s met oudere firmware 
 

• EH-SIO is beschikbaar vanaf 3.5.8.26 of hoger 

• Een gele arcering betekent dat deze versie is gewijzigd sinds de vorige firmware versie. 

• Een licht blauwe arcering betekent dat deze versie gewijzigd is t.b.v. Service Pack 16 
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EHV+ CPU: 
 
 
 
 
 
 
 
 
 
 

 

EHV+ CPU 
Firmware version 3.5.4.11 3.5.4.10 3.4.4.5 3.4.4.4 ≤ 3.4.4.3 

Device description 3.5.4.11 3.5.4.10 3.4.4.32 3.4.4.32 3.4.4.30 

Hardware revision 04 (1102) 03 02 02 02 

Runtime version 3.5.4.10 3.5.4.10 3.4.4.0 3.4.4.0 3.4.4.0 

Compiler version 3.5.5.10 3.5.5.10 3.5.3.60 3.5.1.0 3.4.4.0 

Supported device version EtherCAT 3.5.5.0 3.5.5.0 3.5.3.0 3.5.0.0 - 

Ethernet Adapter 3.4.2.0 3.4.2.0 3.4.2.0 3.4.2.0 3.4.2.0 

Modbus TCP Master 3.5.5.0 3.5.5.0 3.4.3.0 3.4.3.0 3.4.3.0 

Modbus TCP Slave 3.5.4.0 3.5.4.0 3.4.0.0 3.4.0.0 3.4.0.0 

Modbus TCP Slave Device 3.5.5.0 3.5.5.0 3.4.3.0 3.4.3.0 3.4.3.0 

Modbus COM* 3.4.4.0 3.4.4.0 3.4.4.0 3.4.4.0 3.4.4.0 

Modbus SIO-COM** 3.4.4.0 3.4.4.0 3.4.4.0 3.4.4.0 3.4.4.0 

Modbus Serial Device 3.5.5.0 3.5.5.0 3.4.3.0 3.4.3.0 3.4.3.0 

Modbus Master, COM Port 3.5.5.0 3.5.5.0 3.4.3.2 3.4.3.2 3.4.3.2 

Modbus Slave, COM Port 3.5.4.0 3.5.4.0 3.4.0.0 3.4.0.0 3.4.0.0 

EH-LNK 3.4.4.0 3.4.4.0 3.4.4.0 3.4.4.0 3.4.4.0 

EH-SIO 3.5.5.0 3.5.5.0 3.4.1.0 3.4.1.0 3.4.1.0 

Supported library version IODrvEtherCAT 3.5.6.40 3.5.5.10 3.5.3.60 3.5.0.0 - 

IoDrvBase 3.5.2.0 3.5.2.0 3.4.1.0 3.4.1.0 3.4.1.0 

ModbusTCP Slave 3.5.5.0 3.5.5.0 3.5.1.0 3.5.1.0 3.4.1.10 

IoDrvModbusBase 3.5.5.0 3.5.5.0 - - - 

IoDrvModbusTCP 3.5.5.0 3.5.5.0 3.4.3.0 3.4.3.0 3.4.3.0 

CmpApp 3.5.4.0 3.5.4.0 3.4.3.0 3.4.3.0 3.4.3.0 

CmpEventMgr 3.5.4.0 3.5.4.0 3.3.1.40 3.3.1.40 3.3.1.40 

CmpIecTask 3.5.4.0 3.5.4.0 3.4.4.0 3.4.4.0 3.4.4.0 

CmpIecVarAccess 3.5.3.0 3.5.3.0 3.4.2.0 3.4.2.0 3.4.2.0 

IoStandard 3.5.4.0 3.5.4.0 3.4.4.30 3.4.4.30 3.4.4.30 

SysCom 3.5.2.0 3.5.2.0 3.3.2.50 3.3.2.50 3.3.2.50 

SysSocket 3.5.4.0 3.5.4.0 3.4.2.0 3.4.2.0 3.4.2.0 

SysTimer 3.5.2.0 3.5.2.0 3.3.2.50 3.3.2.50 3.3.2.50 

SysTimeRtc 3.5.1.0 3.5.1.0 3.4.3.0 3.4.3.0 3.4.3.0 

UDP 3.5.4.0 3.5.4.0 - - - 

TCP 3.5.4.0 3.5.4.0 - - - 

FDT Manager 3.5.3.30 3.5.3.30 3.4.2.0 3.4.2.0 3.4.2.0 

NetVarUdp 3.5.5.10 3.5.5.10 3.4.4.0 3.4.4.0 3.4.4.0 

* Gebruik i.c.m. CODESYS 3.5 SP16 of nieuwer device versie 3.5.16.0 
** Gebruik i.c.m. CODESYS 3.5 SP16 of nieuwer device versie 3.5.8.21 
 

• Een gele arcering betekent dat deze versie is gewijzigd sinds de vorige firmware versie. 

• Een licht blauwe arcering betekent dat deze versie gewijzigd is t.b.v. Service Pack 16 
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CODESYS 3.4 
 

Voor oudere versies van de EHV+ firmware zijn er verschillende device description files voor 
CODESYS 3.4 en CODESYS 3.5 
 

Type EHV+  CODESYS v3.4 CODESYS v3.5 

 Firmware Device Description File Device Description File 

EHV-CPU1006 ≤ 3.4.4.3 3.4.4.0 3.4.4.30 

EHV-CPU1025 ≤ 3.4.4.3 3.4.4.0 3.4.4.30 

EHV-CPU1025 3.4.4.4 3.4.4.1 3.4.4.32 

EHV-CPU1025 3.4.4.5 3.4.4.1 3.4.4.32 

EHV-CPU1025 3.5.4.10 x 3.5.4.10 

EHV-CPU1051 ≤ 3.4.4.3 3.4.4.0 3.4.4.30 

EHV-CPU1102 ≤ 3.4.4.3 3.4.4.0 3.4.4.30 

EHV-CPU1102 3.4.4.4 3.4.4.1 3.4.4.32 

EHV-CPU1102 (hw rev.01) 3.4.4.5 3.4.4.1 3.4.4.32 

EHV-CPU1102 (hw rev.01) 3.5.4.10 x 3.5.4.10 
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Micro-EHV+ CPU: 
 

 
 

Micro-EHV+ CPU 
Firmware version 3.5.3.44 3.5.3.43 3.5.3.42 3.5.3.41 3.5.3.40 

Device description 3.5.3.44 3.5.3.43 3.5.3.42 3.5.3.41 3.5.3.40 

Hardware revision 1.0 1.0 1.0 1.0 1.0 

Runtime version 3.5.3.40 3.5.3.40 3.5.3.40 3.5.3.40 3.5.3.40 

Compiler version 3.5.5.10 3.5.5.10 3.5.5.10 3.5.3.40 3.5.3.40 

Supported device version EtherCAT 3.5.5.0 3.5.5.0 3.5.5.0 - - 

Ethernet Adapter 3.4.2.0 3.4.2.0 3.4.2.0 3.4.2.0 3.4.2.0 

Modbus TCP Master 3.5.5.0 3.5.5.0 3.5.5.0 - - 

Modbus TCP Slave 3.5.4.0 3.5.4.0 3.5.4.0 3.5.3.0 3.5.3.0 

Modbus TCP Slave Device 3.5.5.0 3.5.5.0 3.5.5.0 3.5.2.0 3.5.2.0 

Modbus COM* 3.4.0.0 3.4.0.0 3.4.0.0 3.4.0.0 3.4.0.0 

Modbus SIO-COM - - - - - 

Modbus Serial Device 3.5.5.0 3.5.5.0 3.5.5.0 3.5.2.0 3.5.2.0 

Modbus Master, COM Port 3.5.5.0 3.5.5.0 3.5.5.0 3.5.3.0 3.5.3.0 

Modbus Slave, COM Port 3.5.4.0 3.5.4.0 3.5.4.0 3.5.3.0 3.5.3.0 

Supported library version IODrvEtherCAT 3.5.5.10 3.5.5.10 3.5.5.10 - - 

IoDrvBase 3.5.2.0 3.5.2.0 3.5.2.0 3.5.2.0 3.5.2.0 

ModbusTCP Slave 3.5.5.0 3.5.5.0 3.5.5.0 3.5.3.50 3.5.3.50 

IoDrvModbusBase 3.5.5.0 3.5.5.0 3.5.5.0 3.5.3.60 3.5.3.60 

IoDrvModbusTCP - - - - - 

CmpApp 3.5.2.0 3.5.2.0 3.5.2.0 3.5.2.0 3.5.2.0 

CmpEventMgr 3.3.1.40 3.3.1.40 3.3.1.40 3.3.1.40 3.3.1.40 

CmpIecTask 3.5.1.0 3.5.1.0 3.5.1.0 3.5.1.0 3.5.1.0 

CmpIecVarAccess 3.5.3.0 3.5.3.0 3.5.3.0 3.5.3.0 3.5.3.0 

IoStandard 3.5.3.40 3.5.3.40 3.5.3.40 3.5.3.40 3.5.3.40 

SysCom 3.5.2.0 3.5.2.0 3.5.2.0 3.5.2.0 3.5.2.0 

SysSocket 3.5.5.0 3.5.5.0 3.5.2.0 3.5.2.0 3.5.2.0 

SysTimer 3.5.2.0 3.5.2.0 3.5.2.0 3.5.2.0 3.5.2.0 

SysTimeRtc 3.5.1.0 3.5.1.0 3.5.1.0 3.5.1.0 3.5.1.0 

UDP 3.5.5.0 3.5.5.0 - - - 

TCP 3.5.5.0 3.5.5.0 - - - 

FDT Manager 3.5.3.30 3.5.3.30 3.5.3.30 3.5.3.30 3.5.3.30 

NetVarUdp 3.5.5.10 3.5.5.10 3.5.5.10 3.5.2.0 3.5.2.0 

* Gebruik i.c.m. CODESYS 3.5 SP16 of nieuwer device versie 3.5.16.0 
 

• Een gele arcering betekent dat deze versie is gewijzigd sinds de vorige firmware versie. 

• Een licht blauwe arcering betekent dat deze versie gewijzigd is t.b.v. Service Pack 16 
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HX-RIO3-CP3MBT CPU / HX-RIO3-CP2MB: 

 
 

HX-RIO3-CP3MBT CPU / HX-RIO3-CP2MBTL 
Device description 3.5.17.30 3.5.11.3 

ROM version 3.000 - 3.002 2.003 

Runtime version 3.5.17.30 3.5.11.0 

Compiler version 3.5.17.30 3.5.11.30 

Visualization Profile 3.5.17.30*2 3.5.11.10*1 

Supported device version Ethernet Adapter 3.5.17.0 3.5.11.0 

Modbus TCP Master 3.5.17.0 3.5.11.30 

Modbus TCP Slave 3.5.16.0 3.5.11.30 

Modbus TCP Slave Device 3.5.17.0 3.5.11.0 

Modbus COM 3.5.16.0 3.5.11.20 

Modbus Serial Device 3.5.17.0 3.5.11.0 

Modbus Master, COM Port 3.5.17.0 3.5.11.20 

Modbus Slave, COM Port 3.5.16.0 3.5.10.30 

Supported library version IoDrvBase 3.5.17.0 3.5.5.0 

IoDrvUtility 3.5.17.0 3.5.11.0 

ModbusTCP Slave 3.5.17.0 3.5.11.0 

IoDrvModbusBase 3.5.17.0 3.5.11.0 

IoDrvModbusTCP 3.5.17.0 3.5.11.30 

CmpApp 3.5.17.0 3.5.11.0 

CmpEventMgr 3.5.17.0 3.5.8.0 

CmpIecTask 3.5.17.0 3.5.9.0 

CmpIecVarAccess 3.5.17.0 3.5.10.0 

IoStandard 3.5.17.0 3.5.10.0 

SysCom 3.5.17.0 3.5.5.0 

SysSocket 3.5.17.0 3.5.9.0 

SysTimer 3.5.17.0 3.5.5.0 

SysTimeRtc 3.5.17.0 3.5.5.0 

UDP 3.5.17.0 3.5.10.0 

TCP 3.5.17.0 3.5.9.50 

NetVarUdp 3.5.17.0 3.5.11.0 

*1 Gebruik CODESYS 3.5.11.30 als de Visualisatie gebruikt gaat worden 
*2 HX-RIO3-CP2MBTL ondersteund geen Web Visu 
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Compilerversie 
Wanneer een nieuw project wordt geopend in de CODESYS-ontwikkelomgeving, wordt hiervoor 
altijd de laatste versie van de compiler gebruikt. Omdat deze versie van de compiler wellicht niet 
compatible is met de firmware uit de CPU, wordt het aangeraden om deze terug te zetten naar de 
compilerversie welke ondersteund wordt door de CPU (zie hiervoor de tabellen op de vorige 
bladzijden).  
 
De compilerversie welke door de ontwikkelomgeving moet worden gebruik, is in te stellen bij 
Project → Project Setting → Compile Options: 
 

 
Het is raadzaam om alleen de compilerversie te gebruiken die ondersteund wordt door de firmware 
van de CPU, omdat zich anders vreemde incompatibiliteitsverschijnselen voor kunnen doen. 
 
 

Ontbrekende libraries 
Bij het starten van nieuwe projecten (of oude projecten zonder Projectarchive) kan het zijn dat nog 
niet alle benodigde libraries geïnstalleerd zijn. Open hiervoor de Library Manager en klik op 
‘Download missing libraries’ knop. Deze knop is alleen zichtbaar wanneer er libraries ontbreken. 
Deze procedure moet mogelijk meerdere keren herhaald worden voor de onderliggende libraries. 
Uiteraard is hiervoor een internetverbinding vereist. 
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Gebruik van de juiste versies van de hardware en libraries 
Wanneer een nieuwe library of hardware wordt toegevoegd aan het project, wordt in veel gevallen 
de nieuwste versie van deze hardware of library toegevoegd. Het is echter goed mogelijk dat deze 
versie niet compatible is met de CPU en daarom moet de gebruikte versie wellicht wordt teruggezet 
naar de ondersteunde versie. 
 
Bijvoorbeeld: communicatie met een Modbus RTU slave instellen in CODESYS 3.5.10.1 voor een 
EHV+ CPU met firmware versie 3.5.4.11. 
 
1. Een COM-poort toevoegen: Rechtsklikken op ‘Device (EHV-CPU1025)’ en kies ‘Add Device…’. Kies 

in het nieuw geopende venster Fieldbusses → Modbus → Modbus Serial Port → Modbus COM, 
version 3.4.0.0 (zie tabel op bladzijde 5). 
 

2. Een Modbus Master toevoegen: Rechtsklikken op de zojuist toegevoegde COM-poort en kies 
weer ‘Add Device…’. Kies vervolgens Fieldbusses → Modbus → Modbus Serial Master → 
Modbus Master, COM port, version 3.5.5.0 (zie tabel op bladzijde 5). Wanneer deze versie niet 
zichtbaar is, moet wellicht de optie ‘Display all versions’ aangevinkt worden. 
 

3. Een Modbus Slave toevoegen: Rechtsklikken op de zojuist toegevoegde Modbus Master en kies 
weer ‘Add Device…’. Kies vervolgens Fieldbusses → Modbus → Modbus Serial Slave → Modbus 
Slave, COM port, version 3.5.4.0 (zie tabel op bladzijde 5). Wanneer deze versie niet zichtbaar is, 
moet wellicht de optie ‘Display all versions’ aangevinkt worden. 

 
Het systeem ziet er dus als volgt uit: 

 

 Versie 3.5.4.11 (compiler 3.5.5.10) 
 
 
 Versie 3.4.0.0 
 Versie 3.5.5.0 
 Versie 3.5.4.0 
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Naam wijzigen van de naam van de (Micro-)EHV+ CPU 
De standaardnaam voor een EHV+ CPU is ‘Hitachi-EH150’ en de standaardnaam van een Micro-EHV+ 
CPU is ‘MICRO-EHV+’. Deze standaardnaam is te wijzigen naar een zelfgekozen naam. Hiervoor 
moeten de volgende stappen worden doorlopen: 
1. Kopieer het ‘config.cfg’ bestand van de CPU naar een lokale schijf. Dit kan uitgevoerd worden in 

het ‘Files’ tabblad van de CPU. 
2. Bewerk het bestand met een tekst-editor (Kladblok of iets dergelijks) en voeg de volgend regels 

toe aan het bestand: 

[SysTarget] 

NodeName=NieuweNaamVanDePLC 

3. Sla het bestand op en kopieer het weer terug naar de CPU. 
4. Herstart de CPU en vervolgens is de CPU zichtbaar onder de nieuwe naam. 
 

Naam wijzigen van de naam van de HX CPU 
De naam van de HX CPU is te wijzigen via het ‘Device’ menu in het tabblad ‘Communication 
Settings’ van de CPU.  
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Minimale inhoud van het ‘Gateway.cfg’ bestand voor het gebruik van 
een USB kabel 
 

In nieuwere versies van CODESYS 3.5.12.x staat het bestand ‘Gateway.cfg’ soms op een andere 
plaats dan gebruikelijk en wordt dit bestand dus niet aangepast voor het gebruik van een USB kabel. 
Het kan dan nodig zijn om het bestand handmatig op te zoeken en aan te passen. Het minimale 
bestand heeft de volgende inhoud: 
 
[ComponentManager] 

Component.1=CmpBlkDrvCom 

Component.2=CmpUsbMpdUsbLib 

 

[CmpBlkDrvUsb] 

0.Name=CmpUsbMpdUsbLib 

0.Dev.0.Name=UsbLibDev0 

0.Dev.0.VendorId=0x04A4 

0.Dev.0.DeviceId=0x0099 

0.Dev.0.Config=1 

0.Dev.0.Interface=0 

0.Dev.0.EndpointIn=0x82 

0.Dev.0.EndpointOut=1 

0.Dev.0.HalfDuplexAutoNegotiate=0 

 

[CmpRouter] 

EnableParallelRouting=1 

EnableLoopDetection=1 

0.MainNet=ether x 

0.NumSubNets=2 

0.SubNet.0.Interface=UsbLibDev0 

0.SubNet.1.Interface=MyCom 

1.MainNet=BlkDrvTcp 

1.NumSubnets=0 

1.SubNet.0.Interface=UsbLibDev0 

1.SubNet.1.Interface=MyCom 

NumRouters=2 

1.Name=Router 2 

 

[CmpGwCommDrvTcp] 

ListenPort=1217 

 

[CmpLog] 

Logger.0.Name=GwLog 

Logger.0.Filter=0xFFFFFFFF 

Logger.0.Enable=1 

Logger.0.MaxEntries=1000 

Logger.0.MaxFileSize=5000 

Logger.0.MaxFiles=3 

Logger.0.Backend.0.ClassId=0x0000010B 

Logger.0.Backend.1.ClassId=0x00000104 

Logger.1.Name=CommLog 

Logger.1.Enable=1 

 

[CmpBlkDrvTcp] 

Name=BlkDrvTcp 

ListenPort=1000 

 

LET OP:  

• Na het aanpassen van dit bestand moet de PC opnieuw worden opgestart 

• Communicatie via een USB-kabel werkt niet met 64-bits versies van CODESYS   
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Gebruikersbeheer in CODESYS op HX PLC 
Vanaf HX firmware 3.5.16.26 staat het gebruikersbeheer standaard aan. Dit betekend in de 
praktijk dat bij ingebruikname van een nieuwe CPU er de verplichting is om een gebruiker aan te 
maken en daarmee in te loggen op de CPU. 
 
Onderstaande melding verschijnt bij het inloggen op de CPU: 

 
 

Vervolgens moet er een gebruiker aangemaakt worden: 

 
 

Daarna moet er met deze gebruiker inlogt worden: 

 
 

Het gebruik van het ‘User Management’ betekend dat voor alle CODESYS communicatie nu de 
inlog noodzakelijk is. Dus ook communicatie van een HMI of SCADA software. 
Exor HMI’s ondersteunen dit pas vanaf JMobile 4.5 SP1 met het CODESYS V3 Handler protocol. 
 

https://eu-prod.asyncgw.teams.microsoft.com/v1/objects/0-weu-d15-004a8fcafb6d69dfff5982f39afbfe3c/views/imgo
https://eu-prod.asyncgw.teams.microsoft.com/v1/objects/0-weu-d6-a046a54d888de64f5cf96e52c467912d/views/imgo
https://eu-prod.asyncgw.teams.microsoft.com/v1/objects/0-weu-d19-37a23a863c51fbeb82e78116c53c598b/views/imgo
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Mocht het aan de PLC te koppelen apparaat geen User Management ondersteunen is dit uit te 
schakelen op onderstaande manier: 
 
Open het Device tab en gebruik het menu: Device > Change Communication Policy 

 
 
Stel het Policy in op ‘Optional user management’ 

 
 
Ga vervolgens online en kies in het right-click menu van het Device de optie 'Reset Origin Device' 

 
Selecteer hier het User Management 

  

https://eu-prod.asyncgw.teams.microsoft.com/v1/objects/0-weu-d20-7644f4ff89fdf34f264de08b3a1121ff/views/imgo
https://eu-prod.asyncgw.teams.microsoft.com/v1/objects/0-weu-d5-037a9244f3b6050c3016fdd99e54ac8d/views/imgo
https://eu-prod.asyncgw.teams.microsoft.com/v1/objects/0-weu-d21-55ef81d716680c7d0db0f22825287cbc/views/imgo
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HX Factory Restore 
 

Mocht het wachtwoord verloren zijn dan kan dit gerest worden door de factory default settings 
procedure te volgen op de CPU.  
 
LET OP: Deze procedure verwijderd ook het CODESYS project en alle instellingen uit de CPU! 
 
< How to reset the factory default settings > 
(1) Remove power from the PAC. 
(2) Toggle the RUN / STOP switch to STOP position. 
(3) Turn on all 2-bit switches (SW1). 
(4) Supply power to the PAC with E.CLR button pressed until “SP” is displayed in the 7-segment LED. 

      
(5) Toggle the RUN / STOP switch to RUN position. 
(6) It takes about one minute to delete boot project. Then “Fn” is displayed in the 7-segment LED. 

      
(7) Turn off all 2-bit switches (SW1). 
      When turning on the power next time, it starts with the factory default settings. 

 

 
 


